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Welcome to iSale!
iSale lets you auction items on eBay from an easy to 
use virtual podium. With iSale, the wonderful world 
of eBay auctioning lays at your fingertips. Trust the 
two time Apple Design Award winning and eBay 
certified application for your Mac.

You’ve Come to the Right Place
Thank you for using iSale, the premier auctioning solution for the 
Mac! Whether you’re just testing the software or bought a license 
already – you’ll notice that iSale makes selling items at eBay easier 
and more profitable than ever!

The Premier Auctioning Solution
for the Mac
eBay became one of the web’s most impressive success stories by 
letting users buy items with a few simple clicks. Selling at eBay, 
however, can be a time-consuming process if you want to get 
things right. iSale was designed to integrate the leading platform  
for online auctioning with the most innovative operating system, 
Mac OS X.

Legendary Ease of Use
iSale bundles the huge set of eBay options in a convenient and 
highly organized interface. All settings, down to to their ordering, 

have been carefully evaluated and placed exactly where you 
would expect them. When setting up your auctions, you can fol-
low the natural workflow provided by iSale or implement your 
own. iSale’s interface does not impose anything: It offers every-
thing you need without overwhelming you with a vast amount of 
settings. 

Apple Design Award 2005 and 2006
equinux closely followed Apple’s Human Interface Guidelines to 
create a true iApp. If you ever worked with iLife, you’ll feel at 
home immediately. Apple ac-
claimed our efforts by awarding 
iSale with the Apple Design 
Award in 2005 and 2006. Few 
apps have ever managed to win 
the most important awards in 
the Mac world two times – iSale 
is simply one of the most well-
designed applications for your 
Macintosh.
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Introduction
iSale provides a unique set of features to make
selling at eBay easier and more successful than ever.

Beautify Your Auctions With iSale Templates
iSale has integrated visually stunning template layouts that will 
distinguish your auctions from all others on eBay. 
Simply select your desired layout and create your 
description. Then just drag and drop your photos 
into your selected template. Your auctions have 
never looked so good!

eBay Stores – Use Your Own Virtual Store
Now with iSale, you can use your eBay Store to sell 
your items. Benefit from your own business channel 
and start selling at a higher level.

Manage Multiple Accounts
iSale lets you manage multiple eBay accounts at once. Just choose 
the current account from a convenient pop-up list, and a single 
status update will bring all running auctions in all accounts up to 
date!

Relist Unsold Items
eBay offers a free relist option for unsold items under certain con-
ditions. iSale natively supports this option, so auctions can be eas-
ily improved to give them another try. If the item is sold during 
the second auction, eBay refunds all fees for the original auction.

Mail Integration via Spotlight
iSale searches all e-mails related to a specific auction and displays 
them in the Sales Status and Memo (In Touch/Bulletin Board) 
window. Stay current and correspond with bidders more effi-
ciently. iSale’s Mail feature is brought to you by Spotlight for 
Mac OS X Leopard. 

Keep in Touch With Your Buyers
Once an auction has been successfully completed, iSale 
retrieves the winning bidders’ details from eBay and 
adds these details to the iSale group in your Address 
Book. With iSale’s Address Book integration, you can easily view 
your previous buyers, launch e-mail campaigns or do any other 
aftersales marketing.

Know Your Numbers
As part of your auction library, iSale displays the number of auc-
tions in each group, subgroup and folder. As a bo-
nus, the current price for running auctions is dis-
played both in iSale and in the iSale Widget.
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View Your Live Auction
Visit your live auction directly within iSale. Get all the information 
you need right now, without accessing the eBay website. With one 
click, you can easily update all information for both running and fin-
ished auctions. Highest bid, name, address, e-mail and selling price – 
everything you need, at the touch of a button.

Rich Text Formatting
Now making attractive auctions is easy, and you don’t 
even need to know HTML! Simply use the Rich Text 
formatting and compose your product description 
with a variety of fonts, colors and sizes. iSale takes care 
of the rest.

Save Money with Picture Services 
Use Macbay or Picasa Web Albums to host your photos! With iSale 
you can upload photos of your eBay items to your Macbay disk, 
Picasa Web Albums or your own FTP account. By storing your auc-
tion pictures with either of these services you can avoid the fees 
for eBay’s photo service. This saves you money on every auction 
and every photo you submit, helping you to optimize your earn-
ings.

Organize Your Auctions
Use “Smart Groups” to quickly view finished auc-
tions, running auctions and the auctions you have 
yet to submit to eBay. Additional “Smart Groups” 
can be created (just as you would create “Smart 
Playlists” in iTunes) that will make managing your 
actions a piece of cake.

Organize Your Sales 
Built-in features allow you to keep an overview of the current 
status of running and finished auctions. iSale’s 
“Next Steps” groups will guide you through the Af-
ter Sales process. Mark the appropriate check box 
in the “Sales Status & Memo” tab to easily track the 
after-sales status of your auction.

International
With iSale, you can submit auctions worldwide on 
eBay. iSale supports eBay USA, Canada, Australia, UK, 
Germany, Austria, Switzerland, Belgium (French), Bel-
gium (Dutch), Italy, Netherlands, Spain and Poland – 
which means you can sell all over the world and still see all the 
information in one convenient window.
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Installation
Install iSale 5
Before you can start auctioning, iSale must be installed on your 
hard drive.

If you bought the retail version of iSale:
‣ Insert the iSale CD into your computer

‣ Double-click the iSale CD icon that appears on your desktop

‣ Drag the file “iSale 5” to your applications folder

If you downloaded iSale from equinux.com:
‣ Double-click the downloaded .zip file

‣ Double click the “iSale 5” icon

‣ Click ”Move” to move iSale 5 to your Mac‘s Applications folder

How to Install the iSale Widget

To install the iSale Widget:
‣ Open ”iSale”

‣ Choose ”iSale 5 > Download Dashboard Widget…” from the top 
menu bar

‣ Double click the downloaded iSale 5 widget

‣ Click ”Install”

Upgrade From Older Versions
Upgrading from an older version of iSale is very similar to install-
ing the software for the first time.

To upgrade to iSale 5, please complete the following steps:

‣ Make sure that you have a valid internet connection

‣ Download iSale 5 at http://www.equinux.com/isale/download

‣ Quit your old version of iSale (if it‘s running)

‣ Install iSale 5 (s. above)
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Migrate Auctions to iSale 5
When iSale 5 is started for the first time, your iSale 3/4 auction 
files will be automatically migrated into the new iSale 5 format. All 
auctions will be copied to a new folder, so you can still use iSale 
3/4 to access your auctions if something goes wrong. 

Should the automatic migration of auctions not work for you, you 
can also migrate your auction files manually.

To migrate your auctions manually, please do the following:

‣ Quit iSale

‣ Double-click your hard drive

‣ Double-click your user home

‣ Navigate to the following location: Library/Application Support 
in your home folder

‣ Move the folder “iSale 5” into the trash, if it already exists.

‣ Duplicate the folder “iSale” (e.g. with Command+D) and re-name 
the copy “iSale 5” (including the space but without the quotes)

Activate iSale
Activating iSale is a simple and straightforward process. Described 
below are three different scenarios: Buy a new license online, acti-
vate a retail version and transfer a license.

Note Your equinux ID will be used to store and manage all of 
your licenses. Whenever you purchase additional li-
censes or other products, please specify your equinux ID.

Buy a License
Obtaining a license for iSale and activating it on your Mac is a 
simple process.

To buy a license, please complete the following steps:
‣ Choose iSale 5 > Buy iSale…

‣ Click Buy iSale

‣ If you are a new customer, choose your country and click Next.

or

‣ If you already registered with equinux, login with your equinux 
ID

‣ Choose the desired license

‣ Click Check Out

‣ Continue shopping for other equinux products

or

‣ Click Continue Check Out

‣ If you are a new customer, register a new equinux ID

‣ Select either Bank Transfer, PayPal or Credit Card as your pre-
ferred payment option

‣ Enter your credit card data, if necessary

‣ Review your order and click Complete Order

If you paid by credit card, iSale will automatically be activated as 
soon as the order process is completed. Your license will be stored 
on your Mac.
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If you paid via bank transfer or PayPal, we will send you an email 
as soon as we receive your payment. Afterwards, you’ll be able to 
activate iSale using the equinux ID and password you created in 
our Online Store..

Activate a Retail Version
If you bought iSale at a retailer, you should have received an “Acti-
vation Code”. Using this code you can activate iSale on your com-
puter. 

To activate a retail version, please complete the following steps:
‣ Choose iSale 5 > Buy iSale…

‣ Click Activate iSale

‣ Register a new equinux ID (if this is your first equinux product)

or

‣ Login with your equinux ID

‣ Enter your Activation Code

Your license will be created and stored on your Mac automatically.

Transfer a License
All licenses for equinux products are hardware-bound. When reg-
istering our software on your computer, the license is created for 
this machine. This means that a license can only be used on a sin-
gle computer.

However, transferring a license to a different computer is easy.

To transfer a license, please complete the following steps:
‣ On your old Mac, choose iSale 5 > Deactivate iSale

The license will now be available for activating the software on 
your new Mac.

‣ Install iSale on your new Mac

‣ On your new Mac, choose iSale 5 > Activate iSale

iSale will automatically fetch the free license.

Note From now on, the software cannot be used on the old 
machine. To transfer the license back, just reverse the 
process described above.
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Overview
In this chapter, we will give you a broad overview of 
iSale’s user interface. After reading this, you’ll be 
familiar with concepts such as the Auction Pin-
board, Groups and the Auction Details.
iSale’s interface was designed using Apple’s Human Interface 
Guidelines and resembles the look and feel of iLife applications.

The main window consists of three areas:

Libraries and groups Auction list Auction view

The “Libraries and groups“ and “Auction list“ areas can be resized 
easily.

To change the width of a column:
‣ Place the mouse pointer over the column’s right edge

‣ Drag the column to your preferred size

Libraries
iSale 5 introduces libraries – allowing you to separate current auc-
tions from your auction archive, or to separate auctions from dif-
ferent areas of your eBay selling activities.

By default, iSale provides two libraries, “My Auctions” and “Archive”.

To move auctions between libraries:
‣ Select the source library in the left column.

‣ Drag the desired auction to the target library.

In our example, an auction is moved from the archive to the “My 
Auctions“ library.
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To create a new library:
‣ Select File > New Library

‣ Click the new library’s name

‣ Enter a name for the library

‣ Hit Return

TIP  We recommend storing your old auctions in a separate 
library, in order to improve iSale’s responsiveness and 
overall speed.

Groups
iSale allows you to group auctions either manually or based on 
certain criteria (like starting price, eBay category etc.). Certain 
“Smart Groups“ like “Running Auctions“ or “Unsold Auctions“ are 
predefined. Groups are subdivisions of your currently selected 
library.

To create a new group and store auctions in it:
‣ Click the “+“ symbol at the bottom left of the main window

‣ Enter a name for the new group appearing in the Groups area

‣ Drag & Drop auctions to the new group

or

‣ Hold down the Command key to select multiple auctions and 
then Drag & Drop them to the new group.

To create a “Smart Group“:
‣ Click the cogwheel symbol at the bottom left of the main win-

dow

‣ Select either “any“ or “all“ as match mode

‣ Choose the desired criteria for the new group

‣ Choose a sort order

iSale will automatically add auctions fulfilling the chosen criteria 
to the new group.

To delete auctions from within groups:
‣ Select the auction you wish to delete

or

‣ Hold down the Command key to select multiple auctions

‣ Press the Delete key

‣ In the dialog box that appears, click Remove from Group to only 
remove your auctions from this particular group

or

‣ Click Delete to completely delete them from iSale
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TIP  You can create Smart Groups to find specific types of 
auctions you would like to move to your archive library 
(e.g. finished auctions older than six months).

Auction List
The auction list will display all auctions contained in the group 
currently selected in the group area. You can choose between a 
basic list style and several beautiful themes.

Use the icons to switch
between a list view and 

a Polaroid view.

Themes
iSale 5 comes with 11 beautiful list themes:

✦ Blue Board
✦ Dark Blue Board
✦ Pinboard – Cork
✦ Pinboard – Fabric
✦ Cubicle
✦ Wood
✦ Chalkboard – Green
✦ Chalkboard – Black
✦ Fridge
✦ Brushed Metal
✦ Black Wood
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All themes display your auctions as virtual Polaroids containing 
the primary picture of each auction. You can change the style by 
clicking the pin symbol above the auction list.

Click to change the style 
of the Polaroid view.

Additionally, you can also resize the Polaroids by dragging the 
slider below the auction list.

Drag the slider below the auction list 
to resize the Polaroids.

Click the icons on the left and 
right to use the minimum or 
maximum size.

Auction Status
Regardless of the chosen style and theme, the status is displayed 
for all auctions.

Status List style Pinboard style

Draft

Running

Finished

Sold

Unsold

Note Finished auctions switch to either sold or unsold after 
the next status update.

For running and sold auctions, iSale will also display the (current) 
price, either as a separate column in the list, or as a little price tag:
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Deleting Auctions
Auctions can be removed from a group or deleted completely. 

To delete a single auction from iSale: 
‣ Select the auction to delete 

‣ Click the “–” button below the auction list  

or  

‣ Press the Delete key 

To delete multiple auctions
‣ Hold down the Command key and click each auction you wish 

to delete

or

‣ Hold down the Shift key and click the first and last auctions you 
wish to delete, to select a range of auctions

or

‣ Select Edit > Select All to select all of your auctions

‣ Press the Delete key

To remove an auction from a group:
‣ Choose the desired group in the group column

‣ Select the auction you want to delete   

or

‣ Hold down the Command key to select multiple auctions

‣ Click the “–” button below the auction list

or

‣ Press the Delete key

‣ Choose whether you wish to remove the auction from the cur-
rently selected group, or delete it from iSale entirely 

Auction View
The Auction View consists of four tabs:

✦ Auction
✦ Details
✦ eBay / eBay Preview
✦ Sales Status & Memo

Auction
The “Auction“ tab has the actual item description along with pic-
tures of the item to be sold.

Details
The “Details“ tab displays all the key information about your auc-
tion, such as price, shipping options etc.
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eBay / eBay Preview
The “eBay Preview“ tab shows the auction as it will appear on 
eBay. As soon as your auction is submitted to eBay, iSale will dis-
play the actual auction page at eBay. The tab title will then switch 
to “eBay“.

Sales Status & Memo
The “Sales Status & Memo“ tab provides status information such 
as the current highest bid, the view and watch count, etc. After an 
item is sold, it will also display a link for contacting the buyer as 
well as some checkboxes to indicate the current status. For a more 
detailed description of this tab, please refer to “After Sales Fea-
tures“ in this manual.
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Getting Started
Before you can go ahead and create your first auc-
tion, iSale needs to know which eBay account to 
use. You may also want to set some defaults for 
new auctions.

Authorize iSale
Before you can start using iSale, you have to authorize the soft-
ware to use an eBay account when submitting auctions and fetch-
ing your running auctions’ status.

If you don’t have an active eBay account yet, you will need to reg-
ister on eBay.

To create a new eBay account, please do the following:
‣ Visit http://www.ebay.com (or some other local eBay website)

‣ Follow the instructions for creating a new account

Once you have a valid eBay account, you can open iSale for 
authorization.

To authorize iSale:
‣ Click the Account button (“Authorize“) at the bottom right of 

the main window

or

‣ Choose iSale 5 > Preferences… > Accounts and click the “+” 
symbol

A browser window will open, displaying the standard eBay login 
dialog.

‣ Enter a valid eBay username and password

‣ Click “Sign In“

‣ Click “Agree and Continue“

eBay will now issue an Authentication Token allowing iSale to use 
this account for listing items.
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Note eBay’s Authentication Token is valid for a limited time, so 
you’ll need to request a new one from time to time. 
Once a token expires, iSale will display an eBay error 
message when trying to upload an auction. In order to 
request a new token, please follow the instructions 
above.

After iSale has been authorized, the Account button will change 
to display the account currently used by iSale.

Multiple Accounts
You can always authorize additional accounts while using iSale.

To authorize additional accounts:
‣ Click the account menu at the bottom right of the main win-

dow

‣ Select Add Account…

or

‣ Choose iSale 5 > Preferences… > Accounts

‣ Click the “+“ symbol at the lower left

‣ Follow the instructions for authorizing iSale (s. above)

To switch between multiple accounts:
‣ Click the eBay Acount menu at the bottom right of the main 

window

‣ Select the desired account

Configure iSale
If you would like to set default parameters for all new auctions, 
the iSale preferences are a great place to store these defaults. 
Please see “Appendix: Preferences“ for details.
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Setting Up an Auction
In this chapter, you will learn how to set up an auc-
tion with iSale using templates, smart date and 
various shipping options. Read on to see how iSale 
implements these features to simplify the task of 
creating an auction.

Creating an Auction
Before submitting an auction to eBay, you can create a draft in 
iSale. While working with a draft, you can choose options like 
starting price and shipping options. You can even add an item 
description, as well as your pictures.

There are two options for new auctions in iSale:

✦ Standard auction (using a template)
✦ Empty auction (no template)

To create a new standard auction, please complete the follow-
ing:
‣ Select the desired library to store your auction (if you work with 

multiple libraries)

‣ From the File menu, select New Auction > With Template.

or

‣ Click the “+” button at the bottom of the Auction list.

The template chooser will open automatically so you can choose 
the best design for your item (please see “Item Description“ in this 
manual for details).

iSale comes with many professional template designs. However, it 
is not required to use a template. Instead, you can apply your own 
style to your listing by creating an auction without a template (or 
by creating your own templates, s. “Create Your Own Templates“).

To create an auction without a template:
‣ From the File menu, select New Auction > Without Template.

or

‣ Click the gear symbol below the auction list and choose ”New 
Auction Without Template“.

Details on formatting your item description without a template 
can be found in “Item Description“.

iSale files all new auctions automatically in the Drafts group. All 
auctions which have not been sent to eBay are filed here.

Most of the steps described below do not require an active Inter-
net connection. There are two exceptions to this general rule: the 
Category Browser and Item Specifics need to communicate with 
the eBay servers. When setting your auction’s category or item 
specifics, iSale will require an active Internet connection.

Enabling Edit Mode
New auctions appear in edit mode. For other draft auctions, you 
can switch to this mode manually.
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To turn edit mode on or off:

‣ Click the auction you want to edit to select it.

‣ Click the Edit button in the bottom part of the window.

Auction Title
After creating a new auction, iSale switches to edit mode and 
highlights the Auction Title placeholder at the top of the Details 
tab. 

Click and type a title 
for the auction.

iSale will use the auction title in the auction list by default, but 
you can manually change the list title without affecting the auc-
tion title (see below). This can lead to confusion, especially when 
using “Smart Groups“.

The title in the auctions list can differ 
from the auction title used on eBay.

Note When contemplating a title, you should always put your-
self in the position of the customer and ask yourself how 
you would search for this item. This is a good way to 
come up with the most appropriate title.

Below your auction title, there are two checkboxes for marking 
the title as bold, highlighting its background and adding a subti-
tle. These options apply to the auction as it is displayed on eBay, 
and eBay charges additional fees for them.

To format your auction title or to add a subtitle:
‣ Select the appropriate options for a bold and/or a highlighted 

title.

‣ Add a subtitle for the auction object if you wish.

Quantity
If you intend to sell more than one item of a kind, you can use the 
“Quantity“ field to specify the quantity. For example, if you had 10 
DVDs of “Finding Nemo”, you would enter “10” into this field. By 
default, iSale assumes a quantity of “1“.

Click and enter a the number of 
items you wish to sell.

Private Auction
With this option, you can hide the eBay user name of your bidders 
and buyers to keep their anonymity. This can be useful for expen-
sive items or items which may embarrass buyers.
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To mark your auction as private:
‣ Select the “Private Auction” option next to the Quantity field.

eBay Site
With the “eBay Site” option, you can choose the region and the 
target market to which you would like to sell your item. In this 
way you can sell your item in a different target market. eBay has 
many local websites worldwide.

Note eBay Motors is listed among the national sites.

Choose the eBay site 
to list your item on.

TIP Don’t forget to use the correct customs and native lan-
guage of the chosen eBay site. If you list an item on the 
French website, your description should also be written 
in French.

Item Location
To set the location of the item:
‣ Click the small grey arrow next to “Location”. A dialog appears. 

Make the appropriate changes and click OK.

Choose a country.

Enter the location’s 
ZIP code and com-
mon name
(e.g. San Mateo, CA).

Category
Next you need to choose the category in which you would like to 
list your item. These categories are determined by eBay. To keep 
these current, iSale downloads the categories automatically from 
eBay and saves them on your hard drive.

To choose a category, please complete the following:
‣ Click the grey arrow next to “Main Category”.

New categories are automatically downloaded to your hard drive.

‣ From the appearing dialog, select the category which best suits 
your item.

‣ Select the appropriate subcategories as they appear.

‣ Click OK to confirm.

Note eBay Motors is a separate eBay site, not a category. To 
sell at eBay Motors, please select the appropriate site 
first (see instructions above).
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Second Category
eBay lets you offer your item in more than one category. This op-
tion is fully supported by iSale.

To choose a second category:
‣ Click the green “+“ symbol next to “Main Category“.

‣ Repeat the instructions for choosing the main category (s. 
above).

Save Your Favorite Category
Sometimes more items are sold from the same category. iSale of-
fers you the opportunity to save time by saving categories you 
use regularly.

To save a category, please complete the following:
‣ Choose the category which best suits your item

‣ Click the grey “+“ icon on the left side of the category path

‣ Your chosen category is now saved

To recall a saved category, please complete the following:
‣ Choose “Favorite Categories”

‣ Click the saved category you would like to use

Search for Categories
Instead of selecting your category, you can also search for it.

To search for a category:
‣ Enter its name in the search bar

TIP If you place the mouse over a category, the category 
number will be displayed as a tool tip.

View Current Listings in the Chosen Category
For setting your starting price it may be helpful to know the 
prices of similar items of the same category. iSale offers you a di-
rect link to the real-time listings of your chosen category.
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To view current listings, please complete the following:
‣ Choose the category which best suits your item

‣ From the category path, choose the level to which you would 
like to be linked

The eBay site with the actual listings of this category will open.

Product Catalog
For certain item categories, you can look up product specs and 
other details in eBay’s Product Catalog. Once you have found your 
product in the Product Catalog, those details will automatically be 
displayed alongside your auction.

To look up a product in the catalog:
‣ If your category supports eBay’s Product Catalog, you should 

see the corresponding checkbox appear

‣ Check the box “Use Product Catalog”

‣ Click the arrow to bring up the catalog search field

‣ Search for your product

‣ Choose “Select Product”

Now details about your product will be shown above your auc-
tion on the eBay website, making it easier for potential customers 
to compare specs and find your item.

Note: The Product Catalog search is category-specific, so only 
search for products that are likely to be found in your category 
(e.g. search for “iPod” in the “MP3 Player” category).

TIP If you haven’t entered an auction title, iSale will auto-
matically suggest a title based on the product catalog 
entry.
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Item Specifics
eBay offers a way to assign item-specific attributes to your auction 
listing. These attributes vary from category to category and are 
assigned based on a preconceived list developed by eBay.

Specifying Item Specifics will improve your chance of making the 
sale by giving your potential buyers an easier way to find your 
item.

Complete the following to set your Item Specifics:
‣ Check the box next to “Use Item Specifics” (if unchecked)

‣ Click the grey arrow next to “Item Specifics”

‣ Provide all the known information about your item. All starred (*) 
Item Specifics are required and must be specified

Item Condition

Depending on your category, you may also need to specify the 
condition of your item in a separate field. 

Choose your category and then select the condition from your 
item. This helps your buyers know what to expect before placing 
their bids. 

To set the item condition:
‣ Choose a category

‣ Select the condition of your item from the Item Condition list

Note that the item condition options depend on the category, so 
you may not have all of the options shown above. 
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Return Policy
You may also want to specify your return conditions (and some 
eBay sites & categories may even require a return policy). 

Specifying a return policy is recommended, as it helps to avoid 
possible disputes with your buyers.

To specify your Return Policy:
‣ Check the box marked “Specify Return Policy”

‣ Select your return options

‣ Optionally click the grey arrow to add additional information

eBay Store
If you configured iSale to use your eBay store (see “Appendix: 
Preferences“), you can enable the store for your auction.

Select this option to use 
your eBay store. Select this option if 

you would like to list 
your item as an 
inventory item.

Click and choose a 
store category.

Note Currently, iSale cannot display the complete category 
hierarchy for your eBay Store. Only “terminal” categories 
(i.e., categories that can be selected for your item) will 
be shown. 

Facebook
iSale can display auctions in your Facebook account, so your 
friends will see what you’re currently selling. For more details on 
Facebook, please see “Appendix: Preferences”.

Select this option to 
display auctions in 
your Facebook
account.

Pricing
First of all, you will want to determine your desired starting price, 
i.e. the minimum price for your item. The currency will be auto-
matically set according to the eBay site chosen.

Note eBay Canada supports both Canadian and US dollars.
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Click and enter the starting price.

When setting your price, please keep in mind that eBay fees are 
calculated based on the starting price of your auction. Most eBay 
auctions start at $1, even if the item has a higher value. Through 
the huge number of bidders on eBay, the item often reaches the 
market price very quickly.

The availability of the pricing options presented below depends 
on the user profile. Additional information can be found on the 
eBay websites.

Fixed-Price Auctions
Instead of specifying a minimum price, you can also set a fixed 
price for your item. Fixed-price auctions are not really auctions: 
Buyers can only purchase your item at the set price, but cannot 
bid.

Click and type in the price for your item.

Select this option to sell
your item at a fixed price.

When you set a fixed price for your auction, you can also choose 
to use eBay’s “Best Offer” feature, which gives buyers and sellers a 
quick, easy and safe way to negotiate prices online. With Best Of-
fer, potential sellers can suggest a price which they are willing to 
pay, and you can decide whether to accept or reject the price.

iSale also offers options to automatically reject all offers below a 
certain threshold, and to accept all offers above a certain thresh-
old. Of course, these thresholds are not disclosed to potential 
buyers.

Select this option to 
allow potential
buyers to suggest a 
price they are
willing to pay.

iSale will automatically decline offers 
below this price. Setting an decline 
price is optional.

iSale will automatically accept 
offers above this price. Setting 

an accept price is optional.
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In the above example, potential buyers could suggest any price 
below 100 US-$. If the suggested price is 60 $ or less, the offer will 
be automatically rejected. If the suggested price is 85 $ or more, it 
will be accepted. If the suggested price is between 60 and 85 $, 
you will receive a notification e-mail from eBay in which you can 
choose to accept or reject the offer.

Note A fixed price cannot be combined with the following 
pricing options.

Buy It Now
If you would like to auction an item, but are also prepared to sell 
it immediately for a pre-determined price, eBay allows you to 
specify a ”Buy It Now“ price in addition to the starting price.

To set the “Buy It Now” price, please complete the following:
‣ Select the field next to “Buy It Now” and enter your price

As long as no one has bid on the item, it can be purchased for the 
“Buy It Now“ price. However, as soon as someone bids on the 
item, “Buy It Now” is no longer possible. Additional information 
about this pricing option can be found on the eBay website.

Note Fixed and “Buy It Now“ prices may look like attractive 
options, but if you over- or underestimate the market 
value of your item, you might not be able to sell it – or, 
worse still, make less money than possible.

Reserve Price
A “Reserve Price“ is the lowest price at which you are willing to sell 
your item. If a bidder does not meet that price, you’re not obli-
gated to sell your item. You set this option, together with a start-
ing price, when you list your item.

To set a “Reserve Price“ for your auction, please complete the 
following:
‣ Click in the field “Reserve price” and enter the price.

The “Reserve Price“ is not disclosed to bidders, but they will be 
told that your auction has a “Reserve Price“ and whether or not 
this price has been met.

Duration and Smart Date
After you’re done with the pricing, you should decide upon the 
auction’s duration as well as the starting date.

To choose a duration, please do the following:
‣ Click the desired duration in the Duration menu

iSale also allows you to plan your auctions around your schedule. 
Select the exact date you want your auction to end and iSale will 
calculate the appropriate start date.
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For example, define Saturday 10 p.m., as your preferred end date 
and iSale will automatically show you the day and time your auc-
tion should be started. 

With iSale’s “Smart Date“ feature, iSale offers you one more 
method to keep yourself organized.

To use “Smart Date“, please complete the following:
‣ Check the box adjacent to “Smart Date“

‣ Click the arrow below the check box

‣ A calendar will appear allowing you to define the auction 
schedule by auction start or end date

‣ Click the calendar to set an end date

‣ When clicking on “End Dates,“ a list of all predefined end dates 
appears. If you choose one, your auction schedule will be auto-
matically set to that date.

TIP For details on how to predefine “Smart Dates“, please 
see “Appendix: Preferences“.

‣ You can also manually configure the start or end date by click-
ing on the day in the calendar

When you decide to submit your auction to eBay, it will be stored 
at eBay and launched on the exact day and at the exact time you 
specify.

TIP Don’t forget to consider the target group when setting 
the start and length of an auction. Buyers of baby cloth-
ing rarely sit at the computer at 3 AM on Saturday morn-
ing. Potential buyers of video games perhaps do.
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Payment
When determining the payment options, you should only offer 
what you are ready to accept.

To specify the payment options, please complete the following:
‣ Click the small grey arrow next to “Payment Options”

‣ Check the desired payment options from the list

‣ To provide more detailed information, use the field “Payment 
Instructions“ (optional)

‣ If you are using PayPal, enter the e-mail address associated with 
your PayPal account.

Founded in 1998, PayPal, an eBay Company, enables any individual 
or business with an e-mail address to securely, easily and quickly 
send and receive payments online. PayPal’s service builds on the 
existing financial infrastructure of bank accounts and credit cards 
and utilizes the world’s most advanced proprietary fraud preven-

tion systems to create a safe, global, real-time payment solution. 
For more information, please visit PayPal’s website.

Most private users offer bank transfer, check and payment upon 
pick-up. You can also choose nothing from this list and explain the 
payment details in the item description (see below).

Shipping
Another important point is shipping. You can choose not to offer 
shipping, to provide the shipping options or to include shipping 
details in the item description.

Professional eBayers indicate the shipping costs in their auctions. 
Without this information, potential buyers will be unsure about 
the complete transaction costs.

To offer local pickup only:
‣ Select the option “Will Not Ship – Local Pickup Only“ next to the 

“Shipping“ parameter

To determine the shipping options:
‣ Choose additional shipping regions by clicking the small grey 

arrow next to “Shipping Regions“

Note The home country of the eBay site chosen is always 
added to the list of shipping regions automatically, i.e. 
items offered on ebay.de will always ship to Germany (if 
shipping is offered at all).
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‣ Click the small grey arrow next to  “National Shipping Options”

‣ Choose the desired shipping service

‣ Set the shipping cost for your item

‣ If you specify a quantity greater than 1 (s. above), you can also 
provide shipping costs for additional items (if someone buys 
more than one of your items)

‣ Click OK

‣ If you offer international shipping, please click the small grey 
arrow next to “International Shipping Options”

‣ Set the international shipping options

Note When shipping to more than one international destina-
tion, you can specify different shipping options for each 
destination.

Calculated Shipping (eBay US)
eBay supports a calculated shipping option via UPS. With calcu-
lated shipping you can offer a detailed shipping price based on 
the dimensions and weight of the item.

To determine the calculated shipping options, please complete 
the following:
‣ Check the calculated shipping option
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‣ Click the small grey arrow next to “Calculated Shipping Details”

‣ Insert the appropriate information.

Shipping Insurance
Decide whether you would like to insure your shipment. This is 
recommended for high value items.

To designate shipping insurance, please complete the follow-
ing:
‣ Open the menu next to “Shipping Insurance”.

‣ Choose the desired option.

Visitor Counter
It is always exciting to see the response from an auction. eBay has 
created a visitor counter which counts the number of visitors to 
your auction. You can even set the design of the counter.

To determine the design of the visitor counter, please complete 
the following:
‣ Click the small grey arrow next to “Visitor Counter”.

‣ Choose your desired design option.

or

‣ Choose “No Counter” if you don’t want to have one

or
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‣ Choose “Hidden” if you would like to have an invisible counter. 
The counter is hidden from your bidders. You can see the 
counter anytime by logging in with your eBay username. This 
option is only available on ebay.com.

TIP iSale incorporates its own counters, available in the main 
window or through iSale’s Dashboard Widget. For more 
information,d see “Running Auctions“.

Picture Service
iSale offers you the ability to post your images via the eBay Pic-
ture Service, Picasa Web Albums or FTP. You also have the option 
to use Supersize pictures.

Note After selecting and setting up a specific picture service 
in the preferences, it will be used as a default for new 
auctions. Existing drafts will not use the new default 
automatically. You can always switch to a different serv-
ice for single auctions.

To make your pictures available in Supersize:

‣ Please check the appropriate checkbox.

To choose a picture service, please complete the following:
‣ Select your preferred picture service (eBay, Picasa Web Albums 

or FTP) from the menu adjacent to “Picture Service.” 

eBay Picture Service
If you choose to use the eBay Picture Service, all auction photos 
will be saved directly on eBay. This is a fee-based service and your 
photos remain saved on eBay.

Note The first picture you upload to eBay is free.

Using Picasa Web Albums
If you have a free Picasa Web albums account, you can store your 
pictures there. iSale can create a dedicated album for all of your 
auction pictures. 

Please see “Appendix: Preferences” for more information on how 
to set up a Picasa Web Albums account in iSale. 

Using Macbay
If you signed up for Macbay, the webspace included with your 
account can be used for uploading pictures.
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Please see “Appendix: Preferences” for more information on how 
to set up a Macbay account in iSale.

Using an FTP Server
Owners and users of FTP web servers can use these servers for 
hosting their images. This is another way to save money with iSale 
for every picture you post.

Please see “Appendix: Preferences“ for more information on how 
to set up FTP.

Note Certain picture options offered by eBay will not be avail-
able when using an alternative picture service.
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Creating your Description
Now that you’re done with all the eBay options,
let’s create a shiny description of your item
and style it with one of iSale’s professionally
designed templates.
When composing a description, think like an advertiser: What is 
important to your potential customers, and which details should 
be mentioned?

Provide all relevant information about your item, including its 
characteristics and condition.

If you did not enter payment and shipping options in your auc-
tion details, you can also provide this information as part of the 
item description.

TIP Be truthful! Do not make up any false information and 
do not keep anything a secret. From a hole in the pants 
to a scratch on the record, your customers need to know 
what they are bidding on. Leaving out information can 
lead to a dispute and even bad feedback.

Templates
iSale comes with visually stunning templates that will distinguish 
your auctions from all others on eBay. Simply select your desired 
layout, create your description, then just drag and drop your pho-
tos into your selected template. Your auctions have never looked 
so good! 

iSale templates are a package of graphics, layout and style direc-
tives, i.e. they are complete with preloaded background graphics, 
borders and text formatting.

A selection of formatting options (like Bold, Italics and Underline) 
is available. These options, in addition to the preloaded format-
ting, will make your auction really stand out.

Note If you’d rather style your item description manually, you 
can choose to create a non-template auction and to use 
Rich Text and HTML formatting instead (s. below).

What You See Is What You Get
Just start typing your text into your chosen iSale template and 
the text will appear exactly as it will on eBay. The same goes for 
images; just drag and drop them into the pre-designated “Picture 
Zones“ and preview your final auction as you create it.
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Select a Template
Any template can be applied to any auction (unless it is a non-
template auction, s. below).

To select a template for an auction:
‣ Choose one of your draft auctions

‣ Click the Templates icon located at the top of the iSale window

Click to show or hide the 
template chooser.

iSale will hide the groups pane and display a template chooser 
instead.

Choose a category 
or keyword to filter 
the list (if desired).

Click a template to
select it.

The selected template “pulsates” 
to indicate your selection.

‣ Close the template chooser by clicking the “Templates“ icon 
again

Collect Your Favorite Templates
If you have templates that you particularly like, you can add them 
to your list of favorite templates.

To add a template to “My Favorites”:
‣ Right-click (or CTRL-click) the template you would like to add

‣ Select “Add to Favorite Templates”

You can now choose to view only your favorite templates by 
selecting the “My Favorites” category in the keyword browser.

To remove a template from “My Favorites”:
‣ Right-click (or CTRL-click) the template to remove

‣ Select “Remove from Favorite Templates”

 35



Modifying the Layout
Each template provides a number of textboxes and picture zones 
forming the layout of the template. This layout can be modified, 
either for a specific auction or permanently.

To start modifying the template layout:
‣ Click the Layout icon at the top of the iSale window

Click to show or hide the 
layout panel.

or

‣ Select Layout > Open Layout Panel from the menu bar

A layout panel will open, displaying a number of different layout 
elements, i.e. textboxes, picture zones, and combinations of both.

To add new layout elements to your auction:
‣ Drag the element from the layout panel to the existing layout

While dragging, a black bar will show where the new element is 
going to appear.

A black bar indicates where the layout element will be inserted.

Drag an element from the layout panel to the template.
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To remove an element from the layout:
‣ Click a layout element to select it

‣ Click the „X“ in the upper-left corner of the selected element

Click to remove the
layout element.

To move an element within the layout:
‣ Place the pointer over a layout block (but not over a picture 

zone), press the mouse button, and move the mouse up or 
down. While dragging, a black bar indicates the element’s new 
position.

Changes applied to a layout will not affect new auctions created 
with the same template, unless you change the template perma-
nently.

Saving Custom Templates
After modifying the layout, you can save the result as a custom 
template which you can use for other auctions.

To save a customized layout as a custom template:
‣ Select Layout > Save Layout as Template…

Custom templates appear in the template chooser under the 
keyword Custom.

To delete a custom template:
‣ Right-click (or ctrl-click) the template

‣ Choose Delete Template

To revert a modified template to its original layout:
‣ Select Layout > Revert Layout
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Edit Your Item Description
After applying a template, you can start editing your item descrip-
tion.

To edit an item description:
‣ Click the Edit button located at the bottom of the window

‣ Click in any of the textboxes (s. below) to add, edit or replace 
text

‣ Insert your images. Detailed instructions on placing images can 
be found in “Adding Pictures“

‣ To leave edit mode, click the Edit button again

Textboxes
Each template contains a number of pre-defined textboxes. These 
boxes are perfectly suited for developing a structure for your item 
description. There are added benefits for both you, the seller, and 
your buyers: You can easily develop new auctions, while your buy-
ers are presented with a clear, understandable and consistent 
structure.

Most templates provide the following textboxes:
‣ Title: This title does not have to be identical to the title used in 

the eBay listing. It can be longer and more descriptive.

‣ Intro: Insert a friendly greeting or welcome message

‣ Item description: Provide a detailed description of your item.

‣ Payment: Give details about your Terms and Conditions in this 
section. For example, explain your exchange or refund policy.

‣ Shipping: Enter shipping details, if not specified in the auction 
details above

‣ Footer: Insert a closing message (“Happy Bidding!“).

All sections are optional – if you do not specify text, the section 
will be hidden in the final auction. You can also define boilerplate 
text (s. “Appendix: Preferences“ for details), so new auctions will be 
prefilled with your standard terms and conditions, intro, etc.

Note You can always add additional textboxes, as explained in 
“Modifying the Layout”.

Picture zones, the other type of layout elements, are described in 
the next chapter (“Adding Pictures”).

Download New Templates
iSale checks for new templates at every start of the application, so 
please make sure you have an active internet connection in order 
to have the templates downloaded and installed.
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To check for new templates manually:
‣ Choose “Check for New Templates“ from the “iSale 5“ menu

If the automatic or manual template check does not result in the 
dialog above, but you know that there are new templates, you 
can also force iSale to check for new templates.

To force a check for new templates:
‣ In the Finder, open the folder Library/Application Support/iSale 

5/ located in your home folder

‣ Delete the file “Templates.plist”

‣ Delete the folder “Templates”

‣ Restart iSale

‣ Open the template chooser

A message will appear stating that new templates are available 
for download.

‣ Confirm that you want to download the templates

All available templates should now be downloaded and installed.

Auctions Without Templates
Instead of using one of the professionally designed templates, you 
can also create auctions without templates. These auctions allow 
you to use advanced Rich Text and HTML formatting to style your 
description text, e.g. to change the font color or increase character 
size.

To create an auction without a template:
‣ Choose “File > New Auction > From Item Lookup”

Note Auctions without templates cannot be turned into regu-
lar auctions later on due to their specific format.

To apply Rich Text formatting to your item description:
‣ Choose the desired formatting options from the “Format“ menu

Note Please keep in mind that certain typefaces might not be 
available on your viewers’ systems. It is recommended to 
use standard fonts like Arial, Helvetica etc.

Before transferring your listing to eBay, iSale will convert all for-
matting to HTML, to allow proper display on any browser.

If you‘re familiar with the HTML markup language and CSS, you 
can apply all the standard HTML and CSS tags to format an auc-
tion yourself.

iSale will render your HTML code in its preview, giving you a good 
impression of how your auction will look at eBay.

To test your HTML code, please complete the following:
‣ Switch your auction into edit mode.

‣ Enter HTML Code in the “Description” field.
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‣ Turn off edit mode.

iSale will display a rendered version of your code closely resem-
bling what your description will look like on the eBay website.

For a detailed simulation of your auction at eBay, see “Review and 
Submit”.

Create Links
eBay recently adopted a more liberal approach to links, and iSale 
now fully supports hypertext links in item descriptions.

To add links to your item description:
‣ Select one or more words

‣ Right-click (or CTRL-click) the selected words

‣ Select Create Link

or

‣ Press ⌘-L

or

‣ Select Format > Create Link… from the menu bar

‣ Enter a target URL

‣ Hit Return

To remove a link:
‣ Right-click (or CTRL-click) some linked text

‣ Select Create Link

‣ Remove the URL and click OK
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Adding Pictures
eBay is no different than any catalog or market-
place: Potential buyers want to see what they are 
buying. Quality photos are worth their weight in 
gold, and iSale offers you many options to bring 
your auction to life with photographs.

Picture Zones
Each auction contains picture zones (aka “Drop Zones“) where 
pictures can be dropped or imported.

A picture zone in an auction 
with template.

A picture zone in an auction 
without template.

In template auctions, you can add additional picture zones, as de-
scribed in “Modifying the Layout“ in the preceding chapter. How-
ever, you cannot add more than 12 picture zones (in both tem-
plate and non-template auctions).

To add a picture zone to a non-template auction:

‣ Click the green button  next to the existing picture zone to 

add a picture zone.

Inserting Photos
iSale 5 introduces a new media dialog which lets you select pic-
tures from your hard drive, iPhoto, Aperture, or the web.

To insert photos from the web:
‣ Drag a picture from the web browser window to a picture zone

To insert local photos:
‣ Click a picture zone to select it

‣ Click the leftmost icon below the picture zone. (Alternatively, 
you can double-click the picture zone.)

Click to insert a picture from your iPhoto or
Aperture library or a picture document.
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A media selection dialog will appear.

To insert photos from your hard drive:
‣ Navigate to the right folder

‣ Select the desired photo

‣ Click Open

or (when not using the media selection dialog)

‣ Locate the image or file on your computer

‣ Drag and drop the picture to a picture zone

To insert photos from either iPhoto or Aperture:
‣ Click the “Photos” category

‣ Select either iPhoto or Aperture in the application list

‣ Select the correct album or collection in your photo application

‣ Choose the best photo of your item

‣ Click Open

Taking Pictures With Your iSight
The iSight is a small webcam from Apple. Many modern Macs 
have an iSight integrated right above their display. For older Macs, 
the iSight was available as an external device, that connected via 
FireWire. iSale allows you to take digital pictures with your iSight.

To take pictures using your iSight for iSale:
‣ Please make sure your iSight is turned on (this happens auto-

matically for built-in iSights)

‣ Click a picture zone to select it

‣ Click the iSight icon below the picture zone

Click to take a picture with your iSight camera.

‣ A window opens that displays what your iSight “sees”
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‣ Direct your iSight on your item (or hold the item in front of your 
built-in iSight) 

‣ Use “Freeze” / ”Continue” in the left corner to see the item tem-
porarily as a fixed-image

‣ When you are satisfied with the photo of your item, click OK

Moving Pictures
Within an auction, you can move pictures between picture zones. 

To move a picture to a different picture zone:
‣ Press and hold the mouse button for a moment over the picture

‣ Drag the picture to the new picture zone

‣ Release the mouse button

Swapping Pictures
When you move a picture to an occupied zone, the occupying 
picture will be moved to the source zone automatically.
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Scaling and Cropping
iSale automatically optimizes your images before they are trans-
ferred to eBay or your desired picture service. These images are 
scaled and saved to your hard drive, as soon as they are imported, 
to optimize memory usage and system performance.

iSale scales your images to the standard eBay photo size or the 
“Supersize“ format if this option is chosen (see below for details). 
iSale’s image scaling will work with all supported picture services 
(eBay Picture Service, Picasa Web Albums, and FTP).

When using a template, you can scale images manually to fit 
them in the picture zones.

To scale and crop images manually:
‣ Click an image to select it

‣ Drag the size slider to choose the desired size

‣ Place the mouse over the image and drag it to change the visi-
ble clipping

Move the slider to adjust the image size.

This only applies to pictures attached to the auction, not to pic-
tures that were directly referenced within an HTML description in 

auctions without a template. These cannot be changed from 
within iSale.

Removing Pictures
Pictures can be removed from a picture zone at any time. As with 
fetching pictures from your hard drive, picture zones in template 
and non-template auctions behave differently.

To remove a picture from a template auction:
‣ Click in the picture you would like to remove

‣ Hit the Delete key on your keyboard

To remove a picture from a non-template auction:

‣ Click the red button  to delete a photo

Gallery Images
eBay offers a so-called gallery option. If this option is chosen, one 
of the auction’s pictures is displayed in the regular auction list 
view on eBay. This feature can attract more attention on eBay.

Note eBay will charge additional fees for gallery pictures.

 44



To set an image as a gallery picture in a template auction:
‣ In a template auction, click a picture, then select the “Use as gal-

lery image” option

Select this option 
to make an image 
the auction’s
gallery image.

In a non-template auction, select the “Gallery Image” option next 
to your desired picture

Note Only one picture per auction can serve as a gallery pic-
ture.

Once you choose the gallery picture option for a picture, iSale will 
display the gallery picture next to the auction title.

The icon indicates that 
the picture will be used 

as gallery image on eBay.

Tip You can use the first picture of your auction as a gallery 
image by default. Please see “Appendix: Preferences” for 
details.

Supersize Pictures
Supersize pictures are extra large photos suited for detailed ob-
jects. Displaying these images in such detail can support your 
auction. With Supersize pictures, be sure that the resolution is 
high enough as not to cause distortion when the image is en-
larged.

Note eBay will charge additional fees for Supersize pictures.

The Supersize option can be enabled in the auction details. See 
“Setting Up an Auction“ for more information.
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Picture Hints
The following guidelines can be useful when taking photos: 

✦ Photograph your items yourself, do not take photos from bro-
chures. This gives the buyer the security of having seen the ap-
praised item.

✦ Show details. Positive details are shown well in photographs, 
but imperfections like scratches should also be shown. This pre-
vents misunderstandings and frustration.

✦ Make sure you have good light conditions and a neutral back-
ground.

✦ Your auction item is the star, not its box or some advertisement 
poster. Stars like spotlight. You should put your object on a 
single-tone tablecloth to present it.
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Adding Videos
In order to present your items in the best light and 
from every perspective, iSale even allows you to 
enhance your auction descriptions with videos.
iSale supports six popular video websites for uploading your films. 
You then add a video placeholder to your auction description and 
paste your video’s address there. And the best part of it: uploading 
videos is entirely free at most of the supported websites.

iSale supports videos from the following websites:

✦ YouTube (www.youtube.com)
✦ Google Video (video.google.com)
✦ MySpace (vids.myspace.com)
✦ AOL Video (uncutvideo.aol.com)
✦ My Video (www.myvideo.de)

The general process for adding a video is as follows:
‣ Upload the video to one of the supported websites.

‣ Go to the video’s web page and copy its URL.

‣ In iSale, add a video layout block to your auction layout.

‣ Select the video placeholder and paste the copied URL.

Note You can also paste the HTML code for embedding the 
video, which many websites provide, instead of the 
video’s URL.

The exact procedure for uploading videos varies depends on the 
website you use. To illustrate the process, we’ll show how to up-
load a video to two selected websites in the following.

Example: YouTube
To illustrate the process for adding videos, we will show how to 
upload a video to the free video website youtube.com. The proc-
ess is similar for the other free websites supported by iSale. We 
will assume that you already have a YouTube account.

Note If you created your video in iMovie, you can upload it 
directly from iMovie. In this example, we show the up-
load process through the YouTube website.

Step 1: Log in at YouTube
Go to www.youtube.com, and log in with your username and 
password.

Step 2: Click the Upload button
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Step 3: Enter information about your video
A page will open where you can enter information about the 
video.

Type in the required information 
about your video.

Make sure your video is 
published as public.
(This is the default setting.)

Click here to proceed.

Step 4: Upload your video
On the following page, you can select your video file and start the 
upload.

Click to upload your video to the 
YouTube servers. Depending on the 
file size, this may take some time.

Click here to select 
your video file.

Step 5: Copy the code for embedding the video
Once the upload is complete, you will see a page with HTML code 
for embedding your video on a website. Copy the code to the 
clipboard.

Select the content of this text field 
and choose Edit > Copy.
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Step 6: Add a video placeholder to your auction
In iSale, select your auction, switch to the Description tab, and go 
to Edit mode. Open the Layout panel (see the chapter “Modifying 
the Layout”), and drag a video layout block to the auction descrip-
tion.

Drag a video layout block from 
the layout panel to the auction 
layout.

A new, empty video placeholder will be inserted into the layout.

Step 7: Insert your video
Click the video placeholder to select it, then click the button 
“Paste HTML Code or URL from Clipboard” below.

iSale will read the video’s HTML code from the clipboard and in-
sert the video into the placeholder.
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Research Assistant
Instead of composing your item description from 
scratch, you can use iSale’s research assistant to use 
material from Delicious Library, FileMaker databases 
or the web.
Often times, you will offer an item that is already described on the 
Web, or is stored in your Delicious Library. The iSale research assis-
tant provides easy and simple access to this data. It can be used 
to collect data for later use, or to fill the current textbox or picture 
zone.

To use the research assistant for collecting clips:
‣ Click the Research Assistant icon in the iSale toolbar

Click to open the
research assistant.

or

‣ Select File > Open Research Assistant…

or

‣ Hit ⇧-⌘-R

To use the research assistant to fill a picture zone or text field:
‣ Click a picture zone or text field to select it

‣ Click the research assistant icon, as shown below:

Click to open the research 
assistant for a picture zone.

Click to open the research 
assistant for a textbox.

In both cases, the research assistant window will open.
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To start a search:

‣ Enter a search term in the search box at the upper left

‣ Hit Return

iSale will start searching the web, your Delicious library, and eBay 
for your search term. The web results from various sources are 
organized in tabs (like in Safari).

Filling Textboxes and Picture Zones
To insert content from a web page into your item description:
‣ Select Web Research from the sidebar on the left

‣ Select text or move the mouse over an imageTwo icons will ap-
pear, of which only the right one is relevant in this case.

Click to insert the image into 
the selected picture zone.

Click to insert the text into 
the selected textbox.

Creating an Auction
You can use the results of an eBay, Delicous Library or FileMaker 
search to create a new auction for the found article with just one 
click.

To create an auction from a search result:
‣ Select eBay, Delicious Library, or FileMaker from the sidebar on 

the left

‣ Click the Create Auction button next to one of the results

Clips
Clips are reusable portions of text or images which can be stored 
and categorized in the research assistant for later use. There are 
also „auction clips“, which contain the contents of an entire auc-
tion.

Image clip Text clip Auction clip
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Creating Clips

To store text or an image as a clip:
‣ Select Web Research from the sidebar on the left

‣ Select text or move the mouse over the image

Two icons will appear, of which only the left one is relevant in this 
case.

Click to create an image clip. Click to create a text clip.

iSale will store the clip in the currently selected group (s. below), 
so please make sure to select the desired group before storing a 
clip.

To create an auction clip:
‣ Select eBay, Delicious Library, or FileMaker from the sidebar on 

the left

‣ Click the Create Clip button next to one of the results

Using Clips

To insert a text or image clip:
‣ Open the research assistant via a textbox or picture zone (see 

above)

‣ Select a clip group in the sidebar on the left

‣ Click a text or image clip to select it

‣ Click “Insert Image Clipping” or “Insert Text Clipping“ at the 
lower-right of the assistant window

To create an auction from an auction clip:
‣ In the research assistant window, select a clip group

‣ Click an auction clip to select it

‣ Click “Create Auction“ at the lower-right of the assistant window

Select a group from the list … … to see the clips in the group.

Click to insert the selected text or image 
clip, or create an auction from an auction 
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Current Research Groups
Groups can be used to organize your clip library according to 
eBay categories or from other perspectives.

To create or delete groups:
‣ Use the buttons below the group list:

Creates a new
clip group.

Removes the
selected group.

‣ Alternatively, you can create a group by dragging a clip from an 
existing group below the list of groups

  

To rename a group:
‣ Click once on a group to select it.

‣ Click again on the group’s name.

‣ Enter a new name for the group, and press Return.

To move clips between groups:
‣ Drag the clip to the target group

Note  Please keep in mind that the information imported from 
public sources may contain copyrighted material. Copy-
righted items are sole property of their respective own-
ers and permission of the copyright owner may be re-
quired for usage.
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Review and Submit
Now that your draft auction is completed, it just has 
to be sent to eBay. iSale offers many features to 
ease this process and keep you up to date.

eBay Fees
Before submitting your auction to eBay, it is recommended to re-
call some facts about eBay auctions. eBay will charge a listing fee 
for every auction which is based on the starting (or fixed) price for 
your item. Only the most basic options are covered by this fee. 
Options like gallery pictures, bold title, etc. will be charged sepa-
rately.

Note There are no additional fees charged by eBay for using 
iSale. iSale will display all regular fees for an individual 
auction prior to submitting it (see below for details).

To check the fees charged by eBay:
‣ Go to: http://pages.ebay.com/help/sell/fees.html

This page lists the fees for ebay.com. Please direct your browser to  
the corresponding page on the preferred ebay site.

Preview Your Draft
Before submitting your auction to eBay, you can check your draft 
auction. Whenever you leave the edit mode, the “Details“ tab will 
display a rendering of your item description. After you’re satisfied 
with the description, you can also check the final appearance.

To preview your draft auction:
‣ Select the draft auction you would like to preview

‣ Switch to the preview by clicking the “eBay Preview“ tab

‣ Inspect all your auction details and the item description

This view will show all aspects of your auction just as if it was cur-
rently live on eBay.

Note The eBay preview is currently only available in one of the 
three interface languages (English, German, or French).

 54

http://pages.ebay.com/help/sell/fees.html
http://pages.ebay.com/help/sell/fees.html


Submit Your Auction
If you’re satisfied with your auction’s appearance, you can put it on-
line. Submitting an auction involves two reviews by iSale and eBay.

Note When using iSale with multiple eBay accounts, please make 
sure that the right account is selected before submitting 
your auction.

At the moment, you can submit one auction at a time, i.e. bulk proc-
essing of items is not supported. While we are convinced iSale is a 
great application for home users, we do not recommend it for 
eBay PowerSellers selling thousands of items per month – they 
would probably miss the option to upload dozens of auctions in 
bulk. We might release a PowerSeller version of iSale in the future.

Note iSale adds a small logo “Created by iSale” to every auc-
tion. This badge is an integral part of each iSale auction 
which cannot be removed.

To submit your auction:
‣ Select your draft

‣ Click Submit at the top right of the iSale window

Mistakes can happen, even with careful scrutiny. After clicking submit, 
iSale will check if all required information has been specified. If 
something is missing or incorrect (e.g. a starting price or cate-
gory), a yellow “glow” will appear around the missing or invalid 
parameter.

The draft will switch to edit mode to allow you to make the re-
quired changes.

TIP iSale can check your auction at any time before submit-
ting to eBay. Just choose “Validate Draft” from the “Auc-
tion” menu.

If iSale did not find any problems, the listing is sent to eBay. eBay will 
do another verification check to ensure that the auction conforms to 
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all eBay policies. If there are any problems, they will be displayed in 
an error message.

If eBay does not throw any errors or warnings, iSale will display 
the listing fees charged for listing your item.

To accept the fees:
‣ Click Submit

Now iSale will upload the auction to eBay and all your pictures to 
the picture service chosen (see “Adding Pictures“ for details).

As soon as your auction has been sent to eBay, the auction status 
changes to “Running”. This has multiple effects in the program:

✦ Banderole: The grey banderole with the word “Draft” turns 
green and is replaced with the word “Running”.

✦ Auction list: The icons in the auction list change to reflect the 
new status

✦ Group membership: iSale moves your auction from the group 
“Drafts” into the group “Running Auctions”.

✦ Preview: The tab “eBay Preview“ changes to “eBay“ and iSale will 
display the actual eBay page in this tab.
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Running Auctions
Now that your auction is up and running, you will 
want to track its status. This chapter tells you how 
to keep an overview of your sales.

View Your Running Auctions on eBay
iSale gives you the option of viewing your running auctions di-
rectly on eBay so that you can monitor their progress.

To view your running auctions on eBay, please complete the 
following:
‣ Select your running auction

‣ Switch to the eBay view by clicking the “eBay“ tab

iSale will display a rendering of your actual auction.

Note iSale will only track auctions created and submitted via 
iSale.

Editing Running Auctions
Editing running auctions is not yet supported by iSale. However, 
due to the great demand for this feature it might be implemented 
in one of the next releases.

Group: “Running Auctions”
iSale files all your running auctions automatically into the group 
“Running Auctions”. This allows you the perfect overview to see 
which auctions are active on eBay.

Subgroup: “Ending Soon”
In this group, iSale files all your auctions which will be ending 
within the next 48 hours. This group is actually a Smart Group, 
and you can edit its criteria by double-clicking the group name. 
Please see “Overview” for more information on Smart Groups.

Get the Current Status
iSale will automatically update the auction status every 5 minutes 
by default. iSale displays the following information about running 
auctions:

✦ The current price
✦ The bid count (how many people have bid on your item)
✦ The highest bidder
✦ The hit count (how many people have visited your auction since 

it was published on eBay)
✦ The watch count (how many people are watching your auction 

permanently through eBay’s “Watch this auction“ feature)

The current price is also displayed as a little price tag in the auc-
tion’s title bar and on the pinboard.
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To manually update the status:
‣ Click Status in the upper right-hand corner of the iSale window

This will update the status of all running and ended auctions (the 
latter are updated exactly once to arrive at their final status – sold 
or unsold).

For privacy reasons, iSale can update auction information only for 
the currently registered eBay user within iSale. If you have multi-
ple auctions submitted with different accounts, you need to 
switch the account first. Please see “Getting started“ for details.

When an auction ends, iSale automatically retrieve the buyer’s 
details. See “Finished Auctions“ for more information.

Observe Your Auctions in iCal
With iSale you can follow your auctions in iCal. Once iCal is acti-
vated in the iSale’s preferences, you will see the end date of your 
running auction. iCal will also notify you when your auction finally 
ends. You can jump directly from iCal to your auction.

To create an iCal event from an auction, please complete the 
following:
‣ Activate the iCal option in the iSale’s preferences before you 

send an auction to eBay (see “Appendix Preferences“)

‣ Submit your auctions to eBay

‣ Open iCal

‣ You will see the end date of your auction as an event now

To jump from iCal back to your auction, please complete the 
following:
‣ In iCal, click the auction you want to jump to

‣ Right-click (or CTRL-click) “url” and choose “Open Link”
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TIP For more information about iCal, please refer to “iCal 
Help” in the iCal Help menu.

Watch Your Auctions in Dashboard
To use the iSale Dashboard Widget:

‣ Install the Widget (see “Installation”)

‣ Click the Dashboard icon in the Dock

or

‣ Press F12

Note The iSale Widget requires an active Internet connection 
to function properly.

As soon as you open the Dashboard, the Widget will load the cur-
rent auction data from eBay. While the data is loaded, a small ar-
row is displayed at the bottom right of the Widget window.

In the iSale preferences, you can choose to observe any recently 
sold and unsold auctions here as well (see “Appendix: Prefer-
ences“).

By default, iSale displays the auction title and the current bid.

Click any of the listed auctions to display:
✦ The remaining time for the selected auction
✦ The highest bidder
✦ The hit count (how many people have visited your auction since 

it was published on eBay)
✦ The bid count (how many people have bid on your item)

The list of auctions can be sorted by different criteria.
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To change the sort order:
‣ Click the “i“ at the bottom right

‣ Choose the sorting criteria from the pop-up menu

‣ Click Done

You can jump directly from the iSale Widget to your auction.

To access your auction from the iSale Widget:

‣ Activate the iSale Widget in Dashboard

‣ Click the arrow button on the left side of ”highest bidding price/ 
sale price“
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Finished Auctions
When an auction is finished, iSale will retrieve addi-
tional sales details from eBay, such as the final sell-
ing price, buyer’s name and e-mail.

Auction Status Changes to “Finished”
As soon as your auction has ended, iSale automatically changes 
the status of your auction to “Finished”. This causes a few things in 
your auction to change:

✦ Banderole: The green banderole with the word “Running” is re-
placed with a blue one with the word “Finished”.

✦ Auction list: The auction icon changes from “Running” to “Fin-
ished”

✦ Group membership: iSale moves your auction from the group 
“Running Auctions” into the group “Finished Auctions”. This is a 
practical way to keep track of all your completed auctions in 
one glance.

Note When an auction ends abruptly because a buyer used 
the “Buy It Now“ option, you will have to click the 
“Status“ button at the top right of the main window to 
make iSale aware of the change.

Status Update
To update the status of finished auctions from eBay, please 
complete the following:
‣ Select the finished auction

‣ Click the “Status” button in the upper right-hand corner of the 
iSale window

Note By clicking the “Status“ button, the status of all running 
and finished auctions will be updated.

Sold or Unsold
As soon as the current status of a finished auction is retrieved 
from eBay, iSale changes the status to sold or unsold. The view of 
the auction will then change:

If the item was purchased:

✦ Banderole: The blue banderole with the word “Finished” will be 
replaced with the word “Sold”.

✦ Auction list: The auction icon changes from “Finished” to “Sold”. 
✦ Group membership: iSale files your auction into the group “Re-

cently Sold”.

 61



If the item was not purchased:

✦ Banderole: The blue banderole with the word “Finished” will be 
replaced with the word “Unsold”.

✦ Auction list: The auction icon changes from “Finished” to “Un-
sold”. 

✦ Group membership: iSale files your auction into the group “Re-
cently Unsold”.

Note The subgroups “Recently Sold” and “Recently Unsold” 
display are useful to watch only the most recently fin-
ished auctions. Double-click them to change their op-
tions.

Sales Details
At the end of an auction, iSale can fetch the details of the sale 
from eBay. Without having to visit the eBay site, iSale can provide 
you with this information at the click of a button. The following 
details are retrieved from eBay:

✦ Final selling price
✦ The buyer’s eBay username
✦ The buyer’s e-mail address

Note Depending on the privacy legislation of the respective 
country, iSale might also retrieve additional information 
such as the buyer’s address and country.
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After Sales Features
Once your auction has ended, there are two possi-
ble scenarios: You have not been able to sell your 
item and would like to give it another try – or you 
need to contact the happy buyer with sales details.

Relist Unsold Items
If your item has not been sold, eBay offers a relist option which is 
free of charge under certain conditions. iSale natively supports 
this option, so auctions can be easily improved to give them an-
other try. The Edit button at the bottom of the main window 
changes to “Prepare for Relisting“ if free relist is available for the 
selected auction.

To relist an unsold item, please complete the following steps:
‣ Click “Prepare for Relisting“ at the main window’s bottom

The auction is sent to the “Relist“ status which is similar to the 
“Draft“ status.

‣ Modify the auction parameters if necessary

‣ Hit the “Relist“ button at the top right of iSale’s main window

‣ Wait for verification by iSale and hit “Relist“ again

If the item is sold during the second auction, eBay currently re-
funds all fees for the original auction.

Find Out Where Your Buyers Are Located
iSale can show you the location of your buyers, based on the ZIP 
code using Google Maps technology. To use this feature, your  
iSale library needs to list at least one successfully sold item. Oth-
erwise, you will see a plain map only.

To view the geographic locations of your buyers, please com-
plete the following:
‣ Select the iSale group “All auctions”

‣ Click Location in the upper part of the iSale window

‣ A new window with the map appears. Pennants on the map 
indicate each buyer of an auction.

‣ If you click a pennant, you will see more information about the 
related auction(s).
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TIP If you want to see the location of specific buyers only, 
create a group or a smart group for them. Select the 
group before you click the "Location" button. iSale 
evaluates only the auctions in a group that is selected. 

Integration With Apple Mail
iSale uses Spotlight to search all e-mails related to a specific auc-
tion in Apple Mail. Search results are displayed in the “Sales Status 
and Memo“ tab. 

To view the mail associated with a particular auction:
‣ Select an auction

‣ In the main auction view, select "Sales Status and Memo"

‣ Click the arrow next to each e-mail to jump to that e-mail in 
Apple Mail

Printing
Whether you want to print a list of sold items for internal pur-
poses, need a delivery note for your buyers or just want an over-
view of all running auctions – iSale’s printing feature has the ap-
propriate layout for all purposes.

iSale provides the following print layouts:

✦ List – compact: A compact list including basic information for 
each auction 
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✦ List – detailed: A more detailed list including the primary picture 
of your auctions

✦ Auction – Delivery note: A personal message for your buyers, 
along with the relevant auction data

✦ Auction – Details: A complete summary of your auction data 
(including the item description)

✦ Label – Address: A label for printing the buyer’s address
✦ Label – Item info: A label for printing basic item info

To print auctions please complete the following steps:
‣ Select the desired group or auction

or 

‣ Hold down the Command key and click each auction you wish 
to print

or

‣ Hold down the Shift key and click the first and last auctions you 
wish to print, to select a range of auctions 

‣ Choose File > Print…

‣ Select the preferred print layout

‣ Select a printer

‣ Click Advanced… to specify additional printing options

‣ Click Print

“Next Steps“
iSale streamlines your After Sales process by providing a group for 
“Next Steps“ groups. This workflow tool will help you to better 
manage your sold items:
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Contact
“Contact“ shows a list of all auctions for which the buyer has not 
yet been contacted.

To contact the buyer of a sold auction:
‣ Select your sold auction

‣ Switch to "Sale Status & Memo" tab

‣ Click the e-mail link next to the buyer’s name

‣ Compose and send an e-mail message for the buyer

‣ Switch back to iSale

‣ Select the “Contacted” option

Feedback
Leaving feedback has now become easier. iSale offers a link to the 
specific eBay page where you simply enter your feedback com-
ment.

To leave feedback for an item sold:
‣ Switch to the "Sale Status & Memo" view of your auction

‣ Click the arrow to the right of "Feedback left"

‣ Your web browser will open with the specific eBay feedback 
page for that particular auction.

iSale will automatically select the “Feedback Left” option. You can 
select or deselect this option at anytime.
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Appendix: Preferences
The preferences can be used to configure the default options for 
new auctions as well as some general settings.

To access the preferences:
‣ Choose Preferences from the iSale 5 menu

Note All changes to auction-specific settings will be used for 
new auctions only.

General
The “General“ tab allows you to set the default eBay site, and to 
set some general options for the iSale Widget.

To change your default eBay site:
‣ Choose the desired site from the pop-up list

To change the status update interval:
‣ Enter the desired interval in the appropriate field

To change the Widget settings:
‣ Check the boxes for all types of auctions you would like to see 

displayed in the Widget

eBay Accounts
In this tab, you set up the eBay accounts you would like to use 
with iSale.

To authorize iSale for a new account:
‣ Click the “+‘ symbol at the bottom of the window

‣ Follow the instructions for authorizing an account (s. “Getting 
Started“)

In the account list in the main window, each user is shown with a 
small picture icon.
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To change the picture for a specific user:
‣ Click Edit… next to the picture

‣ Drag a picture into the window

or

‣ Click Choose… to choose a picture file from your hard drive

or

‣ Click the green camera symbol to capture a picture with a con-
nected iSight

‣ Click Capture

‣ Use the size and rotation sliders to modify the picture

‣ Click Apply to use the new picture

If you intend to use the eBay Store attached to an eBay account, 
you can enable it for new auctions.

To setup iSale to be used with your eBay Store, complete the 
following:
‣ Select iSale 5 > Preferences…, and click Accounts

‣ Click eBay Store

‣ Select the appropriate account

‣ Select the “Use my store“ option

From now on, the option “eBay Store“ will be available with every 
new auction setup in iSale with this account.

If you regularly submit items as Inventory Items, there’s also the 
option to set this status as default.

To list store items as Inventory Items by default:
‣ Select iSale 5 > Preferences…, and click eBay Store

‣ Select the appropriate account

‣ Select the “Use my store“ option

‣ Select the „Make New Auctions Inventory Items“ option

‣ Choose one of the duration options from the pop-up list
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Auctions
The “Auctions“ tab packages all auction-specific settings. It fea-
tures the following sub-tabs:

✦ Details
✦ Location
✦ Payment
✦ Shipping

All parameters available here are explained in detail in “Setup an 
auction“. Whenever a new auction is created, the auction details 
will reflect the settings made in “Auctions“.

Note Changes made here will not affect existing drafts

Boilerplate
Each template contains a number of textboxes. If you use similar 
texts for your auctions regularly, you can define boilerplate text. 
Textboxes in new auctions will be filled with the pre-defined text.

To define a boilerplate text:
‣ Choose the desired text field

‣ Enter your text

Note Rich Text formatting is supported for boilerplate text.
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Pictures
iSale supports four picture services. When using the eBay Picture 
Service, eBay will charge you for each additional picture published 
with your auction. When using either Picasa Web Albums, Macbay 
or FTP, you can upload your pictures for free.

Note After selecting and setting up a specific picture service 
in the preferences, it will be used as a default for new 
auctions. Existing drafts will not use the new default 
automatically. You can always switch to a different serv-
ice for single auctions.

The “Pictures” preference pane is also the place where you can set 
Supersize Pictures as the default.

To use Supersize Pictures as the default for new auctions:

‣ Select the “Supersize Pictures” option

In many cases, the first auction picture is also used as a gallery 
picture. This relation can also be made the default for new auc-
tions.

To use the first picture of each new auction as gallery image:
‣ Select the “Use first Picture…” option

 

eBay
Using the eBay Picture Service is straightforward, so there’s no 
need to configure anything.

To use the eBay Picture Service for all new auctions:
‣ Select iSale 5 > Preferences…, and click Pictures

‣ Choose “eBay“ from the list of available picture services

Picasa Web Albums
Picasa Web Albums is a popular free service from Google that al-
lows users to easily upload and share their pictures on the web. 
Using Picasa Web Albums, you can not only upload your auction 
pictures for free, but also store them in a specific album automati-
cally.
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To use Picasa Web Albums to upload your pictures:
‣ Select iSale 5 > Preferences…, and click Pictures

‣ Switch the picture service to “Picasa Web Albums“ 

‣ Click ”Edit…”

‣ Login with your Picasa Web Album account’s e-mail address and 
password

Macbay
Macbay is an integrated online service. You can use the included 
webspace to upload and store your auction pictures. 

Note Macbay is currently available in German only.

To use Macbay to upload your pictures:
‣ Select iSale 5 > Preferences…, and click Pictures

‣ Switch the Picture Service to “Macbay“ 

‣ Click ”Edit…”

‣ Login with your Macbay account name and password

FTP
If you have access to a public web server, you can upload your 
auction pictures directly to this server.

Note The server needs to support both file uploads via FTP as 
well as downloads via HTTP.
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There are several settings to be made, each of which is explained 
in detail below.

To upload pictures via FTP, please do the following:

‣ Select iSale 5 > Preferences…, and click Pictures

‣ Switch the Picture Service to “FTP“

‣ Check the box “Supersize Pictures“ if you would like to add extra 
large pictures to your new auctions by default

‣ Enter the hostname of your server without specifying the pro-
tocol (ftp://). If your server accepts connections using 
ftp://myserver.com, please enter myserver.com

‣ Specify a port if (and only if ) your server does not use the stan-
dard FTP port (21). If in doubt, leave this field blank

‣ Enter the user name for the FTP connection to your server

‣ Enter the password for the user name specified above

‣ Enter the path of the directory where iSale should upload the 
pictures to (without leading slashes). If your pictures should end 
up in ftp://myserver.com/eBay/pictures, please 
enter eBay/pictures

‣ Enter the “HTTP Picture Path“. This is the public URL where your 
auction pictures will be available. It is not part of the FTP set-
tings themselves, but it is necessary to link your auctions to the 
pictures on your server. It has to start with “http://”

‣ Click “Test Picture Upload“ to make sure everything is setup cor-
rectly

Some of these settings can be quite confusing, so we’ll include a 
step-by-step description of what is tested.

When “Test Picture Upload“ is clicked, this is what happens:
‣ The FTP server is contacted

‣ User name and password are sent

‣ The current directory on the server is changed to the picture 
path (e.g. eBay/pictures)

‣ A test file is uploaded

 72



‣ The FTP connection is closed

‣ The “HTTP Picture Path“ is combined with the name of the up-
loaded test file to create a complete URL (e.g. 
http://myserver.com/eBay/pictures/test.jpg).

‣ iSale attempts to download the file under the above URL

If the last step succeeds, all is good.

If you get an error message, please complete the following 
steps:
‣ Connect to your FTP server manually

‣ Check if the test file was stored at all

‣ Check if the test file was stored in a publicly accessible directory

‣ Check if this directory is accessible under the URL you specified 
under “HTTP Picture Path“

Research
The research preferences define which sources are used by the 
research assistant.

Web Research
When searching the web, iSale will send the search term to all 
web sites listed here.

To add a new web site:
‣ Click the “+” symbol below the list of sites

‣ Enter the URL to the site’s search tool

Example:

If a site offers a search tool at

✦ http://www.somesite.com/run_search?term=iphone

where “iphone” is the actual search term, you should enter

✦ http://www.somesite.com/run_search?term=%@

in the URL field.
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FileMaker
iSale’s research assistant can search FileMaker databases.

To access a FileMaker database:
‣ Provide the database name, path, and layout name

‣ Link the auction values to actual database fields

With these settings, iSale can create complete auctions based on 
FileMaker records.

Facebook
iSale is integrated with the popular networking site, Facebook.

To have your auctions displayed on your Facebook page:
‣ Select “Use Facebook Integration”

‣ Click Authorize…
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‣ Provide your username and password

‣ Click Login

Now iSale is ready to display auctions on your Facebook account. 
Next, you need to add iSale to your favorite applications in Face-
book.

To add iSale to your Facebook applications:
‣ Login to Facebook

‣ Click Applications in the left navigation bar

‣ Enter “iSale” in the search field at the upper right

‣ Hit Return

Facebook will display iSale’s description.

‣ Click Add Application

‣ Click Add iSale to confirm

‣ Switch to your “Profile” page

You will see a list of your currently running auctions (if Facebook 
was activated for them before they were submitted):

To create a new Facebook account:
‣ Click Join Facebook…

Scheduling
The “Scheduling“ tab provides settings to integrate iSale with iCal 
and to predefine “Smart Dates“ for scheduled auctions.

To integrate iSale with iCal:
‣ Select a calendar to add iSale events to

‣ Check the box “Create iCal Events for Running Auctions“

‣ and/or

‣ Check the box “Create iCal Tasks for Finished Auctions”

If you would like the created events to span the full auction dura-
tion:
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‣ Check the appropriate box

Smart Dates are dates which can be used for starting auctions at a 
certain time (e.g. at 11pm), regardless of when the auction is sub-
mitted.

To predefine “Smart Dates“:
‣ Select iSale 5 > Preferences…, and click Scheduling

‣ Click the “+“ symbol to create a new “Smart Date“

or

‣ Double-click an existing “Smart Date“ to edit it

‣ Specify a title for your “Smart Date“ (“High Noon“)

‣ Select a weekday from the list of days (e.g. Wednesday)

‣ Select a time for your “Smart Date“ (e.g. 12pm)

From now on, you’ll be able to schedule every new auction to end 
on “High Noon“, i.e. on a Wednesday at 12pm, by choosing the 
new “Smart Date“.

When setting a smart date for an individual auction, the displayed 
calendar always starts on a certain weekday.

To set the day on which your weeks shall start:
‣ Select the desired day from the pop-up list at the bottom of the 

preferences window
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For more information on using “Smart Dates“, please see “Creating 
an auction“.

Address Book
The settings in this tab allow you to automatically transfer the 
buyers’ contact data to your Address Book.

To integrate iSale with the Address Book:

‣ Select iSale 5 > Preferences…, and click Address Book

‣ Check “Automatically import address information…“

‣ Specify a name for the group in which your buyers‘ addresses 
should be stored. If the group name does not exist, iSale will 
automatically add a new group for the name given

To activate the Address Book automatically from within iSale:
‣ Select iSale 5 > Preferences…, and click Address Book

‣ Check “Launch Address Book when making changes“

‣ Check “Switch Address Book to front“ (if desired)

With all your buyer’s contact data in one place, you can easily do 
e-mail marketing at any time, now or later, with the information 
you have collected.

Printing
This tab lets you specify the default settings for printing auctions 
and auction lists.

To choose a print layout:
‣ Select your preferred template from the list

To define page margins:
‣ Enter the desired margin for all four borders

Note The iSale margins will be added to the margins defined 
for your printer(s) in the system-wide page setup dialog.
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Appendix: Import/Export
iSale now offers a variety of methods to export ex-
isting auctions or import item descriptions. iSale 
searches eBay for product descriptions and photos 
or imports data created with FileMaker or eBay’s 
Turbo Lister. Via the integrated CSV export, iSale 
auctions can be made readily available in your 
FileMaker database or Excel spreadsheet.

Importing Your Auctions From “My eBay“
iSale was designed to create, submit and track auctions. The cur-
rent version of the software does not support “synchronization“ 
with your eBay account to track auctions you created manually 
through the eBay website.

Import and Export Using Auction Files
Single auctions can be imported and exported in iSale’s own for-
mat. This is especially handy when you need to send an auction to 
a friend.

To export a single auction, please complete the following:
‣ Select File > Export > Auction…

‣ Create a name for the file, select your desired save location, and 
click Save.

The file can be sent to someone else or stored as a backup.

To import an iSale auction file:
‣ Locate the auction file in the Finder

‣ Double-click the auction file

The auction will appear as a new draft in iSale.

Import and Export Data From a CSV File
iSale can export any of your auctions into a spreadsheet granting 
you the ability to create individual statistics, when using external 
databases like FileMaker, or to track sales information in Excel. You 
can also use this as a text backup of your auction and easily re-
import it at a later time.

To export an auction as a CSV file, please complete the follow-
ing:
‣ Select “File“ > “Export“ > “iSale CSV…“

‣ Create a name for the file, select your desired save location, and 
click Save

To import a CSV file created with iSale:
‣ Select File > Import > iSale CSV…

‣ Locate your file and click Open

Turbo Lister is a Windows application provided by eBay. When you 
want to migrate from Turbo Lister, you can now import Turbo 
Lister CSV files containing auction information into iSale.
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To import a CSV file created with Turbo Lister:
‣ “File“ > “Import“ > “Turbo Lister CSV“

‣ Locate your CSV file and open it

CSV Field Description
The following table contains all keys iSale imports and exports 
when choosing CSV as a file format. To import iSale CSVs into your 
FileMaker database, just create a layout reflecting the keys.

Key Format Description

eBaySite Number eBay Site

quantity Number no. of items for sale

title Text title of auction

titleBold Number 0=bold title

1=not bold

titleHighlighted Number 0=highlighted Title

1= not highlighted

subtitle Text subtitle of auction

pageCounter Number 0=No Counter

1=Andale Style

2=Green LED Style

3=Hidden Style

Key Format Description

privateAuction Number 0=NO

1=YES

startPrice Number in the form ###,##

fixedPrice Number in the form ###,##

buyNowPrice Number in the form ###,##

reservePrice Number in the form ###,##

durationDays Number no. of days

locationLocation Text your location (e.g. Boston)

payPalAddress Text your paypal e-mail address

checkoutInstruc-
tions

Text signature from the prefer-
ences

imageCount Number no. of images

galleryImageIndex Number which image is used as gal-
lery image

supersizePictures Number 0=NO

1=YES

quantitySold Number no. of items sold
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Key Format Description

hasBeenContacted Number 0=NO

1=YES

hasBeenPaid Number 0=NO

1=YES

hasBeenShipped Number 0=NO

1=YES

didProvideFeed-
back

Number 0=NO

1=YES

salesNotes Text Memo field in After Sales 
Tab

Manual Backup
iSale allows you to create a manual backup of your auction data.

To backup your auctions manually:
‣ Locate the folder “Library/Application Support/iSale 5“ in your 

home folder

‣ Copy this folder to your backup drive or server

To restore your auctions:
‣ Copy the backup folder back to “Library/Application Support“ in 

your home folder
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Appendix: Create Your Own 
Templates
This appendix explains how to create individual 
templates for iSale in just five simple steps.
iSale 5 offers a range of professionally designed templates you 
can use to create great looking auctions that attract more visitors. 
But after a while, you might want to create your own templates.  If 
you have reached this point, this manual is here to help.

It will demonstrate how to create and apply a fully featured iSale 
template that stands out from the eBay crowd.

Step 1: Preparation

Requirements
To create a new template from scratch, you'll need certain appli-
cations, skills and some webspace.

Please make sure you have the following resources available:

✦ An application for creating and exporting the images (e.g. 
Adobe Photoshop, Gimp, GraphicConverter)

✦ A text editor (e.g. TextWrangler, BBEdit, SubEthaEdit, TextMate)
✦ Advanced knowledge of image editing
✦ Advanced knowledge of HTML and CSS
✦ An FTP server to upload the iSale templates

iSale’s default templates are stored inside the iSale application 
bundle.  Custom templates can be stored in ~/Library/Application 
Support/iSale 5/Templates/Custom Templates.

To install a new template:

‣ Launch iSale

‣ Drag the template file onto the iSale icon in the Dock

Inspect an iSale Template
iSale Templates are stored as “packages.” Packages are folders that 
appear in the Finder as files (like most Mac OS X application, for 
example). We suggest to use the demo template for the following 
steps.

To download the demo template:
‣ Go to: http://www.equinux.com/isale/download

‣ Download the demo template

To browse the contents of an iSale template:
‣ Locate the template file in the Finder

‣ Right-click the template package

‣ Choose “Show Package Contents”

Template Contents
After opening a template as described above, you will see the fol-
lowing files:

✦ eqTemplate.html contains the actual HTML and CSS code
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✦ eqThumbnail.png contains the thumbnail image displayed 
in iSale‘s template chooser.

✦ head.png contains the image at the top of an auction
✦ foot.jpg contains the image displayed at the bottom of an 

auction
✦ scale.jpg contains the image displayed on the left and right 

side of an auction

Create a Template Folder
Before you start working on your new template, you'll need to 
create a template folder where all your template files will be 
stored.

To create a template folder:

‣ Copy the demo template package

‣ Rename the package to “myTemplate.iSaleTemplate“, where 
“myTemplate“ is your template's name

Step 2: Create Images
The visual backbone of your new template consists of three im-
ages: header, footer and border (aka scale). In this step, you'll learn 
how to create and store these images as well as a thumbnail for 
iSale's template chooser.

The Header
The header will appear at the top of each new auction based on 
your template.

To create a header file:

‣ Create an image in your preferred image editing application 
(width: 730 pixel)

‣ Save the file as JPEG head.jpg in your template folder
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The Footer
The footer will appear at the bottom of each new auction based 
on your template.

To create a footer file, please complete the following steps:

‣ Create an image in your preferred image editing application 
(width: 730 pixel)

‣ Save the file as JPEG foot.jpg in your template folder

The Border
The border will be formed by repeating a small image on the left 
and the right side of each new auction based on your template.

To create a border file, please complete the following steps:

‣ Create an image in your preferred image editing application 
(width: 730 pixel)

‣ Do not use vertical gradients or similar effects because the im-
age will be repeated vertically

‣ Save the file as scale.jpg in your template folder

Note The filenames above are just suggestions. You can use 
any names you like as long as they match the names 
used in eqTemplate.html.

The Thumbnail
Your template will be displayed as a thumbnail in iSale‘s template 
chooser. That‘s why it is important to have a thumbnail which 
matches the actual look of the template, especially when creating 
more custom templates.

To create a thumbnail file, please complete the following steps:

‣ Create an image in your preferred image editing application 
(size: 128 × 128 pixel)

‣ Make sure that your thumbnail matches the combined head, 
foot and border images

‣ Save the file as PNG “eqThumbnail.png“ in your template folder

Step 3: Modify the HTML File
Your template's layout is defined in an HTML file. This step shows 
you how to modify the HTML file of the demo template package 
for your custom template.
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Modify Meta information
Your template will need to be stored on a public webserver so it 
can be loaded every time someone views your auction.

The template needs to know where it is located so it can link all 
resources correctly.

Base URL
The base URL specifies the directory where the template package 
is stored. It takes the following form:

<meta 
eqbaseurl="http://www.yourserver.com/templat
edirectory/templatename.iSaleTemplate/" />

To modify the base URL, please complete the following steps:
‣ Open the file eqTemplate.html in your preferred text editor

‣ Locate the meta tag eqbaseurl

‣ Modify the URL according to your webserver's path

‣ Save eqTemplate.html in your template folder

If you upload it to your FTP server, the eqbaseurl should look 
like:

✦ http://www.yourserver.com/templatedirectory/thistemplate.iSal
eTemplate/

Template Name
The variable eqtemplatename refers to a unique ID required 
for identifying the template in iSale. It takes the following form:

<meta 
eqtemplatename="BBBF7B04-DDDA-57E2-A9C4-093D
6B421955" />

In order to create a unique ID for your template, please do the 
following:
‣ Open the Terminal application which is in /Applications/Utilities.

‣ Type uuidgen

‣ The output will take the following form: 858C8F3A-3806-
49EF-B7B8-0221C6719084

‣ Open the file eqTemplate.html in your preferred text editor

‣ Copy and paste the output into the eqtemplatename tag

‣ Save eqTemplate.html in your template folder

Template Version
Each template has a template version. In iSale 5 it takes the fol-
lowing form:

    <meta eqtemplateversion="50000" />
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To modify the template version, please complete the following 
steps:
‣ Open the file eqTemplate.html in your preferred text editor

‣ Locate the meta tag eqtemplateversion

‣ Set the version number to “50000”

‣ Save eqTemplate.html in your template folder

Template Provider
Each template contains information about the template author. 
The value of this tag is defined in the Reverse Domain Notation: 

<meta eqtemplateprovider="com.template.custom" />

The eqtemplateprovider tag in your template should look 
like:

✦ com.template.custom

To modify the template version, please complete the following 
steps:

‣ Open the file eqTemplate.html in your preferred text editor

‣ Locate the meta tag eqtemplateprovider

‣ Set it to com.template.custom

‣ Save eqTemplate.html in your template folder

Template Category
All templates can be assigned to categories, so you can easily find 
them using the template chooser. The category is determined by  
the following line:

<meta eqlanguage="en" eqkeywordtype="100-C-
ategory" eqtemplatekeywords="Custom" />

To alter the category,  please complete the following steps:

‣ Open the file eqTemplate.html in your preferred text editor

‣ Locate the meta tag eqtemplatekeywords

‣ Alter its value (e.g. “Custom” or “My Templates”)

‣ Save eqTemplate.html in your template folder

Note Please note that if your category name is too long, the 
template chooser can become difficult to navigate. We 
recommend using less than 20 characters.

Modify the CSS Code
Some CSS declarations are required in an iSale template. Depend-
ing on your template artwork you might have to update the val-
ues in the following CSS declarations:

✦ auctionHead
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✦ auctionFoot
✦ eqLayoutContainer
✦ pageContent
✦ title
✦ endText

To change the CSS, please complete the following steps:

‣ Open the file eqTemplate.html in your preferred text editor

‣ Locate the CSS class definitions

‣ Change the CSS code to fit your needs

‣ Save eqTemplate.html in your template folder

Note External CSS files are not supported, so all style direc-
tives need to be part of eqTemplate.html. 

Basic HTML structure 

iSale 5 introduces the new graphical layout editor which can be 
used for adding and removing content blocks in a template when 
editing the auction. However, a basic HTML structure has to be 
defined in the template’s HTML file.

The HTML code consists of a table with three rows, where the first 
one (auctionHead) holds the template’s header image and auc-
tion title, the second one (auctionContent) the editable area 

where you can drop text or picture placeholders and the third 
one (auctionFoot) the template footer artwork and text field.

The auctionContent row contains a div element which takes the 
following form:

<div id="eqLayoutContainer" class="pageCo-
ntent"></div>

This div will hold all your auction’s content that can be added in 
the application using the layout editor and is therefore required.
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Step 4: Upload Your Template
After you successfully created the images and modified the code, 
it's time to put your template online.

Upload Using FTP
Many hosting providers offer affordable or even free webspace 
suitable for serving your template resources to your auctions' 
viewers on eBay.

To upload your template using FTP, please complete the follow-
ing steps:

‣ Launch your FTP client application and connect to your server

‣ Copy the template package to your server

‣ Make sure that the base URL specified in your template's 
eqTemplate.html matches the public URL of your template

Step 5: Test Drive
Now that your groundbreaking new template is online, waiting to 
be displayed to auction viewers, let's use it for an auction!

Install Your Template in iSale
While your template is publicly available on a webserver, iSale is 
still not aware of its existence.

To install your template in iSale, please complete the following 
step:

‣ Launch iSale

‣ Drop the template package onto the iSale icon in the dock

The template will automatically be installed. You now can choose 
the template in the template browser.

Create a New Auction
What good is a template without an auction to use it?

To create a demo auction, please do the following:

‣ Create a new auction in iSale by clicking the „+“ button under 
the auctions tab

‣ Click the “Template“ button to activate the template chooser.

‣ From the menu, choose “Custom“

‣ Click on your template to apply it to your auction

‣ Open the Layout Editor and add some content areas

‣ Complete your auction details

‣ Check the template display in the “eBay Preview“ tab

‣ If the preview looks good, submit the listing to eBay

‣ Check the auction on eBay

Note  You can save an auction template layout for future use 
by choosing “Layout” > “Save Layout as Template”.

Note equinux does not offer support for custom templates.
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Appendix: Create Your Own 
Print Templates
In addition to custom auction templates, you may 
also create your own print templates. Produce indi-
vidual printouts for your buyers, or create custom 
lists for your inventory.

Step 1: Preparation

Requirements
Before you start creating your own print templates, please make 
sure you have the following resources available:

✦ A text editor (e.g. Apple Textedit, TextWrangler, BBEdit, SubEthaE-
dit, TextMate)

✦ Advanced knowledge of HTML and CSS

Inspect a Print Template
Just like iSale’s auction templates, print templates are stored as 
“packages.” Packages are folders that appear in the Finder as files 
(like most Mac OS X application, for example). We suggest to use 
the demo template for the following steps. 

To download the demo template: 
‣ Go to: http://www.equinux.com/isale/download 

‣ Download the demo template

To browse the contents of a print template:
‣ Locate the template file in the Finder

‣ Right-click the package

‣ Choose "Show package contents"

‣ Double-click Resources

The folder contains the following elements:

‣ Description.plist contains meta data of the template

‣ eqPrintTemplate.html contains the actual HTML and CSS 
code

Create a Template Folder
First, you’ll need to create a template folder where all your tem-
plate files will be stored.

To create a template folder, please do the following:
‣ In the Finder, create a new folder

or

‣ Copy the demo template package

‣ Rename the package to 
myTemplate.iSalePrintTemplate (“myTemplate“ is 
your template’s name)

Create a Resources folder
The Resources folder is located in your template folder and 
contains the actual template files.
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To create a Resources folder, please do the following:
‣ Create a new folder inside your template folder

Step 2: Specify Meta Data
All meta data of a template is stored in the file 
Description.plist, which is located in the Resources 
folder.

The following keys need to be provided:

✦ Bundle contains the name of the template folder
✦ File contains the name of the HTML file
✦ Name contains the name of the template that is displayed in 

iSale

All values have to be specified and the file must be in Apple Prop-
erty List format:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE plist PUBLIC "-//Apple Computer//DTD 
PLIST 1.0//EN" 
"http://www.apple.com/DTDs/PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
! <key>Bundle</key>
!
<string>myTemplate.iSalePrintTemplate</string>
! <key>File</key>
! <string>eqPrintTemplate.html</string>
! <key>Name</key>

! <string>My Template</string>
</dict>
</plist>

Step 3: Create an HTML File

Variables in a Template
Variables in a template are automatically replaced with the actual 
values of an auction by iSale. Using variables allows you to specify 
which information should be displayed on the printout.

The following variables are available:

✦ TITLE contains the title
✦ SUBTITLE contains the subtitle
✦ GROUPTITLE contains the name of the selected group of auc-

tions in iSale
✦ EBAYSITE contains the auction’s eBay website
✦ QUANTITY contains the number of items sold in the current 

auction
✦ CATEGORY contains the auction’s category
✦ STARTINGPRICE contains the starting price
✦ BUYNOWPRICE contains the Buy It Now price
✦ SELLER contains your eBay username
✦ STORENAME contains the name of your eBay store
✦ STARTDATE contains the auction’s start date
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✦ ENDDATE contains the auction’s end date (or the sold date, if 
applicable)

✦ PAYMENTOPTIONS contains the available payment options
✦ SHIPTOLOCATIONS contains the shipping locations for your 

item
✦ SHIPPINGOPTIONS contains shipping options
✦ INSURANCE contains information on insurance
✦ BUYER contains the buyer’s name
✦ ITEMNUMBER contains the item number of an auction that is 

running on eBay
✦ STATUS contains the status
✦ LISTINGFEE contains the listing fee
✦ CURRENTPRICE contains the current price
✦ SALEPRICE contains the final price of a (sold) item
✦ SHORTDESCRIPTION contains the Intro part of your item de-

scription
✦ LONGDESCRIPTION contains the detailed item description
✦ SHIPPING contains the shipping information
✦ PAYMENT contains the terms and conditions
✦ ENDTEXT contains the footer text

If no data is available for a variable when printing an auction, it is 
ignored.

Special Variables
Besides the auction variables, iSale also offers some variables that 
are used for customizing the printing style and options.

The following special variables can be used:

✦ BEGINLOOP indicates the start of a loop
✦ ENDLOOP indicates the end of a loop
✦ ROWBACKGROUND sets alternating background colors in table 

rows

The part of a print template embedded between BEGINLOOP 
and ENDLOOP is repeated for every auction that has been se-
lected for printing.

Note BEGINLOOP and ENDLOOP are required around the 
part of the template containing the auction variables, 
even if you don’t want to print a list of auctions.

If you want to apply alternating background colors in table rows, 
please implement the ROWBACKGROUND variable like this:

<table width="100%" border="0" cellspacing="0" 
class="<!--###ROWBACKGROUND###-->">
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Please make sure that the background colors are specified in two 
CSS classes (.rowLight and .rowDark) like this:

<style type="text/css" media="screen,print">
! .rowLight { background-color: #00000; }
! .rowDark { background-color: #EDF3FE; }
</style>

To add a customized logo to your print template, simply include 
the image file in the RESOURCES folder of your template and 
include a relative link to the image in the template’s .html file:
<img src="MyCompanylogo.jpg">

A very simple print template (without the CSS code) could look 
like this:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 
Transitional//EN"
    
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitio
nal.dtd">
    
<html lang="en" 
xmlns="http://www.w3.org/1999/xhtml" 
xml:lang="en">
<head>
</head>
<body>

<!--###BEGINLOOP###-->
<img src="MyCompanylogo.jpg"><br />
<p>
! Title: <!--###TITLE###--><br />
! Item Number: <!--###ITEMNUMBER###-->
! Status: <!--###STATUS###--><br />
! Listing Fee: <!--###LISTINGFEE###--><br />
! Current Price: <!--###CURRENTPRICE###-->
</p>
<!--###ENDLOOP###-->
</body>
</html>
<!--###EOF###-->

Step 4: Install Your Template
iSale print templates are stored in "~/Library/Application Support/
iSale 5/ PrintTemplates".

To install a new print template, please complete the following 
step:
‣ Locate the template file in the Finder

‣ Double-click the template file

The template will automatically be installed. You now can choose 
the template in the print menu of iSale.
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Step 5: Test Drive
Now you can print out an auction list using your new print tem-
plate.

To print your first auction list:
‣ Choose File > Print…

‣ Select your new template

‣ Click Print

Congratulations! 

Note equinux does not offer support for custom print tem-
plates.
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